
!

�  
Sound Byte Version 4.7.6  December 28, 2016

Sound Byte is a computerized cart machine program. It is very similar to the so-called cart 
machines used at radio stations in the past. Each clip (recording) - a jingle, advertisement, etc, 
was on a cartridge, which could be quickly selected and played. Following this introduction are 
chapters that explain how to use and register (pay for) your copy of Sound Byte.

Sound Byte brings the cart machine to the computer age. You can assign select up to 75 
recordings to a rack, and assign each to a button. Clicking on a button plays that recording. 
Multiple recordings can be played at the same time. 

Sound Byte comes in three versions:

Sound Byte Lite handles up to a single rack of carts, or 75 clips. The registration fee is only 
$39.

Sound Byte handles up to 5 racks of carts, or 375 clips.  The registration fee is only $79.

Sound Byte Pro a try, which supports up to 50 racks, or 3750 clips.  The registration fee is 
only $149.

Until you buy your copy, it will operate like the Lite version. In addition, the program will 
occasionally display reminder messages.

Sound Byte handles all of the audio formats supported by QuickTime, including:
AIFF
WAV
AU
MP3
AAC/m4a

If you'd like to create your own recordings, please give our program Audiocorder a try. It may 
be downloaded from the following URL:
http://www.blackcatsystems.com/software/audiocorder.html



 

Note that Audiocorder is only available for the Macintosh.

Sound Byte is the perfect application to use whenever you need to quickly and easily play a 
variety of recorded sounds.

Possible Uses:
Radio Stations - jingles, advertisements, PSAs, songs, announcements, and more.

Plays and radio/TV productions - perfect for playing sound effects.

DJs - set up your play-list for the evening.

Sporting events - play sound effects when the home team scores, etc.

 



 

Requirements:

Macintosh:  Mac OS X 10.6 or later.

Windows: Windows XP / Vista / Windows 7, 8, 10. QuickTime must be installed. It can be 
downloaded for free from this URL: https://support.apple.com/kb/DL1822?locale=en_US

Installation:

After decompressing the download archive, you’ll have a folder containing the Sound Byte 
program, this documentation that you’re reading now,  and an order form.

If you’re running under Mac OS X and have installed a disk image file containing Sound Byte, 
please be sure to move the Sound Byte folder to your hard drive before trying to run it. That is, 
don’t try to run it off a mounted disk image.

If you want to put Sound Byte into the Mac OS X Dock, make an alias of the program icon, and 
put the alias into the Dock. 

 



 

Rack Window:

When you start the program, you'll see a window with 75 buttons, arranged in a 5 by 15 array. 
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Each button represents one sound file (clip) that may be played.  This window is also called a 
“rack” - a term from back in older days of radio when recordings (songs, stations jingles, 
advertisements, etc) were all stored on cartridges, or carts for short. The carts were all kept on 
a rack. To play a song or ad, the DJ would grab the cart, plug it in, and play it. Many consoles 
allowed several carts to be queued up ahead of time, so the next one would always be ready 
to play. 
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The top line of each button shows the title of the recording. By default it is the name of the file, 
but you can change it. Below this the length of the recording is shown, in 
Hours:Minutes:Seconds. At the bottom of the button is a volume control, so you can set the 
playback level for that particular recording. In the upper right corner of the button is an 
indicator that is normally black, and turns green when the recording is playing. Inside this, the 
hotkey character for the recording is shown. Each button can be assigned a hotkey, typing this 
key starts (or stops) the recording. You can also start a recording by clicking on the button. 

 



 

Click on the indicator, or the upper part of the button. Don’t click on the volume slider area. You 
can stop playback by clicking on the green indicator, or typing the hotkey again.

You can also navigate the carts by using the arrow keys. The up, down, left, and right keys will 
advance from the currently playing cart to the adjacent cart, and start it playing. You can also 
use the space bar to play the next (to the right) cart. This is handy if you need to play a 
sequence of carts in a row in order. Just set the up in the rack in the correct order, and hit the 
spacebar to start the next one. If you’re already in the right most column, hitting the space bar 
again will jump to the cart in the left most column of the next row.

If the buttons are too small, you can use the Change Cart Size item in the Action menu to 
display larger sized carts. 

Here’s what a button looks like when the recording is playing:
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The second line now shows the elapsed playback time as well.

Clicking on the Mute button (or selecting Mute from the Edit menu, cmd-T) will mute any 
currently playing carts, which is handy during a voice-over, etc.

Also be sure to check the section on Preferences, which can set some useful features of 
Sound Byte.

There are two ways to assign a clip to a button. The first, and easiest way is to just drag the 
sound file into the button.  

Holding down the shift key when you drop the file will change the file that is played, but keep 
the button color, text, hotkey, etc all the same. 

To change the details of a cart button, right click on it, or, you can click on the button while 
holding down the command key (the alt key under Windows). This will bring up the a window 
called "Cart Options", shown below:
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Clicking on the "Select Sound File..." button allows you to select the clip to associate with this 
button. If the file is grayed out in the open file dialog list, chances are the filetype is not set to 
one of those recognized by Sound Byte as a valid file.  Filetypes recognized are: 

'AIFF'

 



 

'MooV'
‘Mp3 '
'MPEG'
'MPG3'
'sfil'
'Sd2f'
'ULAW'
'WAVE'
'????'

It’s always possible that the filetype of the recording file is not recognized by Sound Byte. You 
can try dragging the file onto an empty cart, and see if it is recognized.

The name of the file is automatically used as the button title. If you'd like to change the title, 
type the name you'd like to assign to this sound clip in the field called Title. You'll want do do 
this after you select the sound file, or the name you've typed in will get replaced by the name 
of the sound file, and you'll have to enter it in again.

If you select the Abort other sounds playing option, then whenever you play this sound, any 
other sounds that are currently playing will automatically be stopped. This can be much more 
convenient than having to manually stop the other sounds that may be playing.

When Click restarts playback is checked, a cart will restart playback from the beginning 
when clicked, rather than stop playback.

If you select the Loop option, then when the sound is done playing, it will automatically be re-
played.

If you select the Disable After Playing option, then when the sound is done playing, the cart 
will automatically be disabled. It will appear faded in the Rack, and you won’t be able to play it 
again until you’ve selected the Reset Disabled Carts option in the Edit menu. This is useful 
when you only want to play a sound once, and don’t want to accidentally play it again, and 
want to make it so that unplayed sounds are more obvious in the Rack window.

The Play Backwards option will cause playback to start at the end of the recording, and it will 
be played backwards. Note that there may be some clicking or other distortions to the sound 
when this option is used, nothing can be done about that. Please be sure to fully test this 
option before using it in a production setting, if it is important to you. 

The Click Start Aborts Others option, when enabled, will stop playback of any other carts 
which are playing, when this cart is clicked to start playback. This works the same as the 
option in the Sound Byte preferences, but allows a cart-by-cart control of this feature.

The Click Pauses Playback option, when enabled, will pause playback of this cart when the 
cart button is clicked, rather than stopping playback which is the default operation. This works 

 



 

the same as the option in the Sound Byte preferences, but allows a cart-by-cart control of this 
feature.

If you select the Lock Volume option, then the volume slider can’t be adjusted. This is to 
prevent accidentally changing the volume setting when you click on a cart to play it.

You can also assign a hot key to this sound. This allows you to play the clip by just typing that 
key, without using the mouse. Hot key's may include the shift key, that is, you can use both 
upper and lower case letters.  If you’d like to use one of the function keys (F1, F2, etc) type in 
the function key name (which must be in upper case). Note that some function keys have 
special uses with various operating systems, and may not be used. 

Clicking on the "Set Button Color..." button lets you change the color of the button. This can be 
very handy if you want to color code buttons to make them easier to find. You'll get a color 
picker window, with lots of options, depending on which operating system you're running. 
Select the color, then click on OK.

If you want to change several carts to the same color, the easiest way is to change one of 
them, then select Copy Cart Color under the Maintenance menu. An open hand cursor will 
appear. Click on the cart with the color you wish to apply to other carts. The cursor will change 
to a closed hand. Then click on the other carts you wish to change to that color. When you’re 
done, hit the ESC key, and the cursor will change back to the normal pointer.

Set In/Out brings up another window, to allow you to precisely set the in and out times. Read 
further down under Set In Out Window for more details.

The Fade Rate field specifies how quickly the sound fades to silence when you select the 
Fade Current Cart item from the Edit menu. Larger numbers cause faster fades, and the fading 
rate is linear. A value of 1, for example, fades from maximum volume to complete silence in 
about 32 seconds. A value of 8 does the same fade in about 4 seconds. 

Fadeout specifies when (referenced from the end of the track), the cart should automatically 
start to fade out. For example, 5 means that 5 seconds before the end of the track, it will begin 
to fade (at the specified Fade Rate). 

You can check Fade out cart on click to have the cart fade out if it is clicked while it is 
playing.

Checking Fade In will cause the cart to fade in when it is played.

Clicking on the Details button will bring up a window that shows the location of the sound file.
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You can use the Rate value to change the playback speed. A value of 1 will play back at the 
normal speed. A value of 1.1 would be 10% faster than normal, 2 would be double speed, etc. 
Negative values can be used for reverse playback, although the sound may be distorted.

The Pitch value, as expected, controls the pitch of the audio. Here, zero is normal pitch, a 
value of 1.0 would be an increase of one cent, 100.0 is one semi-tone up, and 1200.0 would 
be one octave higher. Negative values can be used to lower the pitch.

The Repeat value allows a cart to be automatically replayed. Enter in a time (in HH:MM:SS) as 
the repetition period. When you click on the cart, it will play normally. Then, after the repetition 
period, it will be played again, and so on. This can be used to play periodic announcement 
messages, etc. When this is active, the indicator box in the upper right corner will be blue, 
rather than the usual black. To stop the periodic playback, click on the cart again, and the 
indicator will turn back to black from blue.

The MIDI values allows you to specify which note on a connected MIDI keyboard will cause the 
sound file to play (it works just like a hotkey). You need to have MIDI enabled in the Sound 
Byte Preferences for this to work. Just hit the note on the keyboard and the channel number 
will appear in the first entry box, and the note in the second. Or you can type in the channel 
and note values. You can leave (or make) the channel value blank, so it is ignored. The MIDI 
channel and note will be displayed in the lower center of the cart, when MIDI is enabled. 

Reload Sound Files on Play
Normally, Sound Byte pre-loads all sound files when a rack is opened, to reduce the delay 
when a cart is started. When this is enabled, Sound Byte will re-load a sound file when it is 
played. This is useful if you have dynamically generated sound files that change after the rack 
has been loaded.

Don’t Mark As PLAYED
This overrides the setting in the main Sound Byte preferences to mark played carts, for this 
particular cart. 

Using the popup menu at the bottom of the window, you can select the sound output device to 
use, if you want the sound to play on a device other than the default. You can also specify the 
channel numbers to use (if your device has more than two output channels) for the left and 
right outputs. These settings will override any in the overall Sound Byte preferences.

 



 

When you're done, click on the OK button.  Clicking on the Clear button will erase the button 
name and file association, essentially erasing the button entry.

 



 

Set Cart In Out Window

!

This window allows the cut in and out times for the cart to be precisely set. At the top of the 
window, the waveform for the sound file is displayed. The slider below and to the right allows 
the magnification level to be changed, letting you zoom in and out. You can also scroll around 
a zoomed in waveform use the scroll bar below it. 

Shift clicking sets the in point, and control clicking sets the out point.  The out point is 
referenced in two ways, first the time from the start of the file, and second from the end of the 
file. You can change either, and the other will also change appropriately. 

The portion of the sound file that will actually be played is surrounded by gray. 

The fade rate and fadeout time from the end of the file, as well as whether or not the sound file 
will fade in, can also be set.

The Play, Pause, and Stop buttons work as expect.

 



 

 



 

Drag and Drop

If you want to move buttons around (within the same rack), you can just drag one button on top 
of the other. They will automatically trade places. If you want to replicate a button, hold down 
the shift key as you drag it to a blank cart, and you will get a copy. If the destination cart is not 
blank, it will be overwritten. You need to grab the lower right corner of the cart to be able to 
drag it.

Inserting and Deleting Carts

You can insert a blank cart by selecting Insert Blank Cart from the Management menu, then 
click on a cart. That cart will move to the right, as will neighboring carts further down the rack, 
including lower rows, making room for a new blank cart. The movement will continue until the 
first blank cart is found. Note that you need to have a blank cart further down on you rack for 
the last cart to move into. 

You can delete a cart by selecting Delete Cart from the management menu, then click on the 
cart to be deleted. Carts to the right (and further down the rack) will move to the left. 

When selecting either of these options, the cursor will change to a closed hand, until you click 
on a cart. If you decide that you don’t want to insert or delete a cart, select the menu item 
again, and the cursor will change to the standard arrow pointer.

Playing a Sound

To play a clip, just click on the button, or type the hot key. The indicator in the upper right of the 
button will turn green, to show that the clip is playing. 

The volume slider can be used to adjust the playback volume of the cart. You can also position 
the mouse cursor over the cart, and use the scroll wheel.

Clicking on the indicator while the clip is still playing will stop playback. You can have more 
than one clip play at the same time.

You can stop all currently playing clips by pressing the ESC (escape) key.
 
Holding down the control key while clicking on a button will bring up a window that will let you 
specify the starting point in the recording to begin playback. This is useful if you do not want to 
start playback at the beginning. After entering in the start time and clicking OK, the cart will be 
paused. Select Pause Playing Carts from the Edit menu (control or command U as the 
shortcut) to begin playback.

More About Racks

 



 

Under the Rack menu is a list of the racks available. To chose a new rack, just select it from 
the menu. The name of the rack can be changed by selecting “Rename...” from the Rack menu 
while that rack is the currently active window.

Your rack is automatically saved when you quit the program, or close it.

If instead of the volume slider, you’d rather see a progress bar showing the amount of the cart 
that has played so far, select Show Play Progress from the Edit menu. Each cart will now look 
like the following:

!

With this view enabled, you can click on the progress bar to set the playback position of the 
cart. You do this while it is playing, or before it plays, to cue the position, then click on the cart 
to start playback.

Clicking on the cart while holding down the shift and control keys will bring up a window to 
allow you to precisely cue the playback start time, down to the second.

You can select Show Volume Sliders to get the sliders back, or select Show Nothing if you’d 
rather see neither.

Selecting Max All Volumes from the Edit menu will set all volume sliders to the maximum 
volume.

Selecting Fade Current Cart from the Edit menu will fade the volume of the currently playing 
cart over a few seconds. This operation of this function is undefined if you have more than one 
cart playing. You can select the fade rate for each cart by cmd-clicking on the cart to bring up 
the editing window for that cart.

Selecting Pause Playing Carts from the Edit menu will pause the playback of all active carts. 
Selecting it again will start them playing from were they left off.

If you want to add several files to a rack at once, select all them, and drop them onto the small 
area labeled “Drop Files Here”. Each file will be assigned to an empty cart button.  You can 
always re-arrange the order of the carts by dragging them around, if they don’t land in the 
order you wish. You can double click on this area to toggle it between four orders for the carts 
to be automatically arranged:
Horizontally
Horizontally and Alphabetized
Vertically
Vertically and Alphabetized

 



 

Clicking the MUTE button will mute playback of carts. Clicking the TALK button will change the 
volume to a lower setting, you can adjust this setting while TALK is pressed, and it will be 
saved for the next time you press TALK. This can be useful when doing voice-overs. You can 
use the command-K keyboard shortcut to toggle the TALK button.

If you do not know on which rack a specific cart is located, you can search for it. Select Search 
For Cart from the Edit menu, and a window will appear. You can type part of the name of a 
cart, click Search, and all carts containing that text will be displayed. Double click on one of 
them, and that rack will be opened (if not already opened) and the cart will be highlighted with 
a red border, so you can easily see it. Clicking on the cart will remove that red border.  

 



 

Rack Spreadsheet

Available under the Management menu. This lets you quickly change many cart settings. 
Some, like enabling/disabling logging on a per cart basis, are only available on the 
spreadsheet. 
 
 
Organize Racks - Setting The Rack Order Under The Racks Menu

Available under the Management menu. This lets you change the order of the racks appearing 
under the Racks menu. Select this, and a new window appears, with a list of all of the Racks. 
You can drag and drop to re-order this list. After you close the window, the Racks menu items 
will be re-ordered, as per the list. There is also a button in this window to go back to the default 
order, if you wan to quickly do this.
  

 



 

Queuing Carts

You can queue carts on a rack, so that as soon as one cart is done playing, the next queued 
cart will play. This lets you quickly and easily specify a sequence of carts to play, without 
having to manually start each cart at exactly when the previous cart ends.

To do this, you must enabled queuing in the Sound Byte preferences if you would like to be 
able to queue all carts, or you must enable it on a cart by cart basis. When a cart (or all carts) 
are enabled for queuing, you lose the ability to play two or more of those carts at the same 
time.

When a cart is playing, if you click on another cart (or type the hotkey for it), that second cart 
will not start playing immediately, but will instead be queued. When the first cart is done 
playing, it will then start playback.

Carts that are queued will have a number displayed on the cart, in a large blue font, indicating 
the position in the queue. Number 1 means that cart will start playing immediately after the 
currently playing cart stops, queued cart 2 will play next, and so on. As the carts move up in 
the queue, the displayed numbers will update.

If you have two or more carts with the same hotkey, and type the hotkey to queue them, both 
will be queued, but they will not play at the same time. The first cart (as defined by highest row 
and leftmost column) will play first, then the next cart.

 



 

Archiving Racks

You can archive the contents of a rack (along with the referenced sound files). This archive can 
be used as a backup, or as a way to move an entire rack to another computer. Note that this 
feature is only available with the Regular and Pro versions of Sound Byte, not the Lite version.

To archive a rack, open and select that rack window, then choose Archive from the 
Management menu. You will be asked to specify the name of archive file to be created. The 
archiving process can take some time, depending on the size of the various sound files. A 
progress bar will update during the archiving process.

To unarchive, you need to open and select the rack window that you wish the archive file 
contents to be restored to. Note that all of the existing carts on that window will be erased (the 
referenced sound files themselves will not be affected). Select Unarchive from the 
Management menu. You will be asked to specify the name of archive file, and the destination 
folder, where the sound files will be stored.

By default, all of the sound files will have a four digit number prepended to their name. This is 
to handle the situation where the rack has carts that reference two or more sound files of the 
same name (but originally stored in different directories), so that the unarchived files do not 
overwrite each other. During the unarchiving process, you will alerted to this renaming, and 
given the option to not perform it, if you wish, at your risk.

If you wish to move the rack to another computer, you need to copy the archive file to the 
second machine, which must have a licensed copy of Sound Byte installed. Then run Sound 
Byte, unarchiving the file as described above. Both copies of Sound Byte must be the same 
version number, and the same platform (you cannot transfer between Mac and Windows, and 
on the Mac you cannot transfer between PPC and Intel systems).

 



 

Play List 

The Play List allows you to select cuts to play ahead of time, organize them in a list, and 
control their playback.

!

For each recording in the playlist, the title (name of recording file), length in Hours : Minutes : 
Seconds is shown, as well as how much time into the playback session that recording will 
start. A small black dot appears to the right of the title of the active (currently playing or next to 
play) recording.

To create a play list, select New PlayList... from the File menu. You’ll be asked to name the 
play list when you close the window, so it can be saved. If you save your playlists in a folder 
called Playlists, you can bring up a list of all of the playlists in that folder by selecting Show 
Play Lists Window from the File menu. Just double click on a playlist in that window to open it.

You can drag a cart over to the play list window from a button on the main window, or you can 
drag a sound file over directly from Finder.  Drop it onto the “Drag Files Here” box to have them 
appended onto the end of the play list, or drag them into the position where you want them. 
You can always change the order of items in the play list up or down, by dragging the entries 
around.

 



 

You can then drag additional cuts over. Dragging them after cuts already in the play list 
schedules them later. Dragging them onto an existing scheduled cut schedules them before 
that cut.

You can delete a scheduled cut by selecting it, and selecting Delete Playlist Track from the Edit 
menu. You can can also re-arrange the order by dragging entries around.

You can open an existing play list by selecting Open Play List from the File menu, and then 
selecting the play list file. 

The play list has seven buttons. Let’s go through them in order from left to right:

!  Play - Clicking this button starts playback of the selected recordings, in order. A small dot 
is displayed next to the active (playing) cut.

!  Stop - Clicking this button stops playback. Clicking Play again will start the active 
recording, at the beginning.

!  Pause - Clicking this button pauses playback. Clicking Play will start it again, right where 
it left off, not at the beginning of the recording.

!  Skip - Clicking this button will stop playback of the currently playing recording, and start 
playback of the next. Think of it as a way to abort a cut, and jump right to the next one.

!  Rewind - Stops playback, and selects the first recording as the active recording. When 
play is clicked, the first recording will start playback.

!  Loop - When depressed, the loop button will cause the playlist to start over again, after 
the last cut is finished.

!  Play One Cut - Click once to select, again to de-select. When selected, only one 
recording will be played when Play is clicked. Pressing Play again will play the next recording. 

 



 

Useful to queue up several recordings in a row, and play them one by one, under your control 
as to when they start.  For example, sound effects for a play or other production, etc.

Hitting either the spacebar or return/enter key when a playlist window is active will begin 
playback of the currently selected track.

The up and down arrow  keys can be used to navigate up and down through the list of tracks.

The left arrow key will restart (or start) playback of a track.

The right arrow key will stop playback of the current track and start playback of the next track.

Add Pause - Clicking this button adds an entry called PAUSE PLAYBACK. You can drag this 
entry to position it wherever you wish, and you have have several of these in a playlist. When 
playback reaches this entry, it will stop. You can then click the play button to start playback 
again with the next entry. This allows you to create a playlist for an extended time period, 
where you will only want to play a few tracks in a row, such as a series of commercials or other 
announcements, songs, etc. 

Add Delay - Clicking this button adds an entry called DELAY PLAYBACK. You can drag this 
entry to position it wherever you wish, and you have have several of these in a playlist. When 
playback reaches this entry, it will stop, then resume after a specified time period. This period 
defaults to 10 seconds, and may be changed by double clicking the DELAY PLAYBACK entry.

The Cross Fade entry can be used to specify a time period, in seconds, over which the 
currently playing track will be faded out, while the next track will be faded in.

Each  track also has a Cut In and Cut Out time, in seconds, that you can specify. The track will 
start playing at the Cut In time, and the end of the track will be offset by the Cut Out time (for 
example, if a track is 3 minutes, 20 seconds long, and the Cut Out time is 5 seconds, then it 
will stop playing at 3 minutes, 15 seconds).

To change the Cut In or Cut Out times, or to delete a track, double click on it to bring up an 
editing window.

There is a volume control for each playlist, which controls the playback volume of tracks on 
that list.

Your play list is automatically saved when you quit the program, or close it.

You can open a window with a list of all of the playlists that are in your Playlists folder by 
selecting Show Play Lists Window from the File menu. Double clicking on an entry will 
automatically open that playlist. Note that you need to save your playlists in the Playlists folder 
for them to appear in the listing.

 



 

You can drag and drop a playlist file onto a cart button in a rack. When you do this, the name 
of the playlist will appear as the cart’s title. If you click on the cart, the playlist will open, and the 
first track in the playlist will play. Each subsequent click on the cart will play the next track of 
the play list.

A playlist can be made to open and play when a cart button is pressed. Drag and drop the file 
for the playlist (from the Finder or Windows Explorer, not the list of playlists within Sound Byte 
itself) to a cart. The name of the cart will become the name of the playlist. 

When this cart is run, the playlist will automatically open, and playback will begin. If the playlist 
is set to only play one track at a time, then only the first track will play, each subsequent click 
of the cart (or press of the hotkey) will play the next track.

The popup menu can be used to specify the sound output device, and the left and right 
channels can also be specified (or leave them black to use the defaults).

 



 

Timed Play List

!

The Timed Play List allows you to create a set of sound files, each one will play at a user 
defined time of the day. This can be a handy way to have lead in or out jingles play at certain 
times, without manual intervention. Very useful for a live show, for example. You could have a 
certain clip automatically start to play at certain times, to remind you that it’s time to go into a 
break.

Create a new timed play list window, and then drag sound files (or carts) into it.  The start time 
for each recording will default to 00:00:00 which is midnight. Go to this value, and click it twice 
to allow you to edit it. You can then change it to whatever time of the day you wish. Use 24 
hour time, that is, 2 PM would be 14:00:00.  When you close the window for the first time, or if 
you have made changes to it, you’ll be asked to give it a name so it can be saved. 

When the specified time of any recording in an opened timed play list window is reached, that 
recording will start to play. You can have multiple recordings play at the same time, if you wish.

You can open a window with a list of all of the timed playlists that are in your Playlists folder by 
selecting Show Timed Play Lists Window from the File menu. Double clicking on an entry will 
automatically open that playlist. Note that you need to save your timed playlists in the Playlists 
folder for them to appear in the listing.

 



 

By selecting Reset Start Times from the Management window, the start times for each track in 
a timed playlist window can be changed. You will be presented with a small window, where you 
specify the start time for the first track (it will default to the current time). Each subsequent 
track’s start time will also be changed, keeping the same relative spacing between start times 
as previously existed.

 



 

Preferences Window

The preferences for Sound Byte are divided into two sections, General, those for the entire 
app, and those specific to Carts. 

General:

Check for IR Remote
Will check for the presence of an Apple IR Remote (only works on Mac OS X). If found, you 
can use the up/down/left/right buttons to select the cart to play next, and the play button to play 
it. 

Load Sound Files To RAM
When checked, Sound Byte will load each sound file in a rack to the computer’s memory. This 
can reduce the delay before playback, at the expense of taking longer to load a rack, and 
potentially using a lot of memory.

Copy Files To Sound Byte
When this is enabled, Sound Byte will make a copy of any sound files dropped onto a cart, and 
play that copy. 

Check For Updates
When checked, Sound Byte will check each time you start the program to see if there is a 
newer version available. No information is sent other than your current OS, version and 
registration information, so that the server can see if there is a new version available for you. 
You can disable this feature by unchecking the box.  

Time Offset
This allows you to take into account time delays.  Enter a value here in seconds. The clock on 
the rack window will run ahead by this amount. Any timed play lists will then start ahead of time 
by this amount as well.

Log Files Played
When checked, Sound Byte will update a text file with a line each time a cart  is played. This is 
useful for tracking what files are played, for royalty and other purposes. Click on the File button 
to specify the name of the log file. There is an entry in the spreadsheet to enable/disable 
logging on a per cart basis.

Each entry contains the date, time, cart length, cart name, and file name, all comma delimited.

Use Serial Port
If a serial port is selected in the popup menu, Sound Byte will assert the RTS and DTR lines 
when a sound file is being played. This can be used to control external hardware, such as a 
transmitter. You need to enable this using the checkbox to the left, first. 

 



 

Sound Output Device
You can select the sound output device to use, if you want the sound to play on a device other 
than the default. You can also specify the channel numbers to use (if your device has more 
than two output channels) for the left and right outputs.

Reload Sound Files on Play
Normally, Sound Byte pre-loads all sound files when a rack is opened, to reduce the delay 
when a cart is started. When this is enabled, Sound Byte will re-load a sound file when it is 
played. This is useful if you have dynamically generated sound files that change after the rack 
has been loaded.

Backup Rack files
When checked, Sound Byte will store backups of racks in a directory called Backups, located 
in the SoundByteRacks directory in the Documents directory for your user account. You can 
use these backups if one of your Rack files gets corrupted or otherwise damaged. Note that 
backups will be written each time a rack is closed, and are never deleted. So you may want to 
periodically deleted older backups if you turn this feature on. 

Use QuickTime
This can only be changed in the Windows version of Sound Byte. It defaults to on, meaning 
Sound Byte uses QuickTime for Windows to play sound files. If you turn it off, Sound Byte no 
longer needs QuickTime. However, not all features of Sound Byte will work in this mode, so 
you turn it off at your own risk. This is available for those who do not wish to use QuickTime. 

Carts: 

Space skips to next cart
Hitting the spacebar will cause the next cart (to the right) to start playing.

Arrow Keys Don’t Start Cart Playback
Using the arrow keys (or remote) to move the selector to chose the next cart to play won’t 
actually start playback, you need to press enter to do that.

Space aborts playback
Pressing the spacebar will stop playback, handy if hitting the small ESC key is too difficult. 

Click restarts playback
When checked, a cart will restart playback from the beginning when clicked, rather than stop 
playback.

Click on playing cart pauses playback instead of stopping it
Instead of stopping, a currently playing cart will pause when the cart button is clicked. 
Playback will resume when it is clicked again.

Cart start aborts other carts playing

 



 

Starting a cart will stop any other playing cart(s)

Fadeout cart rather than stopping it
Instead of abruptly stopping, a currently playing cart will fade out when another cart is started.

Disable Played Carts
After a cart is played, it is disabled, so it cannot be played again, until you re-enable all 
disabled carts. 

Play Carts Continuously
After one cart ends, the next cart (to the right) will play. When the end of a row is reached, the 
first cart in the next row will play. 

Flash cart red when nearing end
Checking this will cause the cart to flash red when it is nearing the end of playback.  Enter the 
number of seconds before the end of playback in the box next to the option.

Turn entire cart green when playing
Checking this will turn the entire cart green, rather than just the small activity box, making it 
easier to see which cart is playing.

Randomly Play Hotkey Carts
Normally, if more than one cart has the same hotkey, typing that hotkey will result in all those 
carts being played. When this option is checked, only one of the carts, randomly selected, will 
play.

Queue Cart Playback
See the previous section titled Queuing Carts

Keep Cart Duration 00:00 After Played
After a cart is played, the duration will stay set to 00:00 and not be reset to the actual value.

Adjust cart font size to fit title
The title font size will be reduced as necessary so it fits.

Mark played carts
When a cart is played, it is marked as such, so you can keep track of what has been played.

Open Playlists assigned to Carts
When checked, any playlists that are assigned to a cart will be opened when the rack is 
opened. These playlists cannot be closed while the rack is opened.

Track Number of Times a Cart Is Played
Sound Byte will count the number of times a cart is played, and if it is greater than zero, 
display it in the lower right corner of the cart. You need to quit and restart Sound Byte to reset 
this.

 



 

Set cart color based on state
When checked, the cart color will automatically be set based on it’s state:
Gray: No sound file assigned to cart
Yellow: Not yet played
Green: Currently playing
Blue: Previously played

 



 

MIDI Management

Select Setup MIDI Device from the Management menu to bring up this window:

!

Select which MIDI device you wish to use from the popup menu. Be sure to plug in your MIDI 
device before running Sound Byte.

When enabled, Sound Byte will allow notes from a MIDI keyboard to initiate sound file 
playback. If no MIDI input device can be found, an error message will be displayed when 
Sound Byte starts. You can also specify a MIDI note value that will abort sound playback, 
much like the ESC key, as well as perform other functions via triggers. 

Both the channel and note value can be specified. If the channel value is left (or made) blank, 
then that note from any channel will be used as a trigger. 

 



 

Click on the button for the trigger you wish to set the MIDI note for. The note field to the right 
will turn red. Then hit the note on your MIDI device, and the note number will be placed into the 
note field, which will then turn black. The same will happen for the channel. You can clear the 
channel field if you wish that note from any channel to act as a trigger. Repeat this for as many 
functions as you wish. If you wish to clear the note for a function, click the button so the field 
turns red, then click the Clear Selected Trigger button.

You can also set the notes for sliders or knobs to control the volumes of currently playing carts, 
as well as the overall rack/computer volume. Set them the same way, except adjust the slider 
or knob you wish to use. 

Note that in use, the slider or knob is only read when it is adjusted. So when you start cart 
playback or Sound Byte itself, the volume will not be set until you adjust the control. This 
means there could be a discontinuity when you first adjust it, if the control setting is different 
from the cart or computer volume setting.

                                       

 



 

Locking Sound Byte Against Unauthorized Changes

It may be desirable to prevent users from making accidental changes to cart settings and rack 
layouts. This can be done by selecting Lock Settings from the Edit menu, and checking the 
checkbox. 

When checked, users will not be able to edit cart options, drag carts, or add new carts to racks.

To re-allow changes to be made, uncheck this checkbox.

Please be sure to remember the password you set for this. If you forget it, we will NOT be able 
to assist you in bypassing it.

 



 

Computer User Account Issues

Under some computer operating systems, there can be issues where Sound Byte is run under 
more than one user account, since the location of the file where some settings are stored 
varies for each user account. There is now an option to have this file stored in the same 
directory (folder) as the Sound Byte application itself. If you wish to do this, run Sound Byte 
once under a user account. Find the file SoundBytePrefs (use your computer’s search feature 
to locate it, as each operating system puts it in a different location) and move it (or make a 
copy) to the same folder that contains the Sound Byte application itself.  From now on, when 
Sound Byte is run, it will use this file to store the settings.

 



 

Buying Sound Byte

Sound Byte is distributed as shareware, if you continue to use it, you're required to register 
your copy. Until you register, the program will occasionally display reminder messages, and 
you'll be limited to ten minutes of use at a time.

By purchasing your copy of Sound Byte, you'll help support the program, and encourage the 
development of future releases. 

After buying, you'll be entitled to one year's worth of updates and new program versions.

The registration fees for each version are as follows:

Sound Byte Lite $39

Sound Byte $79

Sound Byte Pro $149

When you buy Sound Byte you'll receive a registration code, by email, usually within a few 
minutes. If you don't get your registration code within a day or two, please send an email to: 
info@blackcatsystems.com.

If you want to use Sound Byte on multiple computers, you'll need to register a copy for each 
computer. If you'll be using Sound Byte on many computers, you may want to take a look at 
our site licensing options, which can save you a great deal of money.

Thanks again for giving Sound Byte a try.  

Black Cat Systems
4708 Trail Court
Westminster, MD 21158
USA

email:    info@blackcatsystems.com
Web:      http://www.blackcatsystems.com/software/soundbyte.html

 



 

Ordering by Check or Money Order

To order by check, please print, fill out and mail the following form, along with your payment. 
You can pay with a wide variety of cash from different countries but at present if you pay via 
check, it must be a check drawn in US Dollars. While there is the risk of loss in the mail, 
currency is also OK, including foreign currency.

Please make sure you include your email address with your payment. That way we can send 
the registration code to you, so you must include your email address. If you do not send us a 
valid email address, we have no way to send you the code. Please write clearly.

I would like to buy ____ copies of Sound Byte Lite, at $39 US per copy.

I would like to buy ____ copies of Sound Byte, at $79 US per copy.

I would like to buy ____ copies of Sound Byte Pro, at $149 US per copy.     

__ I would also like a CDROM with a copy of all of Black Cat Systems software, including 
Sound Byte, for $10 including shipping.

Email Address: ______________________________________________

Name: ___________________________________________________

Address: __________________________________________________

City: _______________________   State/Province:_________________

ZIP/Postal Code: __________________  Country: ___________________

Computer Model: _______________________         OS Version: _________

Enclosed, please find my check / money order / cash in the amount of $_______
Maryland Residents please add 6% sales tax.

All payments must be in either checks/money orders in US dollars drawn on a US Bank, or an 
International Money Order. If this is inconvenient, or you would like to order with a credit card, 
please order online at http://www.blackcatsystems.com/register/soundbyte.html

Mail this form, along with payment, to:

Black Cat Systems
4708 Trail Court

 



 

Westminster, MD 21158
USA

 



 

Ordering Online By Credit Card

To order online with a credit card, go to the following URL:
http://www.blackcatsystems.com/register/soundbyte.html

Please make sure you include your email address when you order online. That way we can 
send the registration code to you, so you must include your email address. If you do not send 
us a valid email address, we have no way to send you the code.

 



 

Entering Your Registration Code

When you register Sound Byte, you'll receive an email containing your registration code. Select 
Register... from the File menu, and enter the code into the window that appears, along with 
your Name and Email address (optional):

!
 
Please be sure to enter your name and registration code exactly as shown in the registration 
email you received. Your code is locked to your name.

 



 

Sound Byte Version History

4.7.6 – December 28, 2016
Added the ability to change the racks menu order (Organize Racks). 
Bug fix -  the menu would disappear after archiving/unarchiving racks under Windows.

4.7.5 – August 4, 2016
Added an option to not use QuickTime in the Windows version, with reduced functionality.
Added window to search racks for carts with specified text in their title.
Command-K toggles the Talk Button on and off.
Cart color can be set by state.
Changes to preferences window layout.
Carts can be ordered vertical or horizontally, or alphabetically, when dropped onto the rack 
window.
Bug fix - cart start aborts other carts playing now works across all open racks and respects the 
fade setting.
Bug fix - drawing of progress indicator for medium sized carts.
Bug fix - if both “fade in” and “queue cart” were enabled, the cart would immediately play, 
instead of being queued. 
Improved redraw of carts when the rack window is resized.

4.7.2 – July 6, 2015
Bug fix – carts marked to loop will now not restart after they fade out.
If racks were previously displayed on an external monitor that is no longer connected, they will 
be displayed on the main monitor the next time Sound Byte is run.

4.7.1 – May 28, 2015
Added display of MIDI channel and note in lower center of cart.
Bug fix – cart titles were not always displayed in bold when they should be.
PLAYED text for carts changed in color, positioned behind other cart text.
PLAYED text now displayed after the cart finishes.
Bug fix – playlists added to carts were not always working correctly.
Added a spreadsheet option to log on a per cart basis, and some other options.
Bug fix – carts playing backwards did not always correctly stop playing.
Sped up quitting the app.

4.7.0 – March 13, 2015
Updates for Mac OS X Yosemite.
Bug fix – Clicking on playback buttons in an empty playlist could cause a crash.
Bug fix – Multiple carts could not be added to a rack at the same time (Windows only)
 
4.6.4 – September 22, 2014
Bug fix – delays and pauses in playlists were not always being saved. 

4.6.3 – July 29, 2014

 



 

Added a checkbox in the Preferences window to enable the serial port popup menu.
Bug fix – the channel for the MIDI Abort note was not being saved. 

4.6.2 – July 10, 2014
Bug fixes for the iPhone/iPad remote control app.

4.6.1 - June 27, 2014
Fixed a bug that could cause a crash under Windows when re-ordering entries in a Playlist.

4.6.0 - June 19, 2014
Changed MIDI channel numbering to start at 1 rather than 0.
Bug fix – preserved volume setting of queued carts when playback was stopped early.
MIDI control now includes support for channels.
Added MIDI triggers for various commands.
Log file now includes the length of the sound file.
Carts that will be reloaded on play are opened from a copy now, so the sound file can be over-
written by other apps.
Added insert cart.
Added delete cart.
Added option to not mark individual carts as PLAYED.
Added option to force reload of sound file when a cart is played, both in prefs and cart options.
PLAYED text on carts that have been played is more subtle in color.

4.5.0- January 28, 2014
Added marking of played carts
Added an option to disable played carts to preferences 
Added cart text color and bold
Alphabetizing rack is now not case sensitive
Added option to drop the serial port DTR and RTS lines when a cart is paused. 
Added a management menu item to disable cart clicks
Enlarged active area for dragging a cart.
Bug fix - carts would not fade in when triggered by MIDI.
Bug fix - could try to set in/out times on a playlist in a cart, which would cause a crash
Bug fix - MIDI control not working when multiple racks were open.

4.4.0- February 20, 2013
Added the preferences option to copy sound files to Sound Byte
Added the preferences option to track the number of times a cart is played
Added the preferences option to set cart duration to 00:00 after it is played
Added the Lock Settings... option to the Edit menu
Fixed a bug with clicking on a cart fading in not stopping the cart playback
Fixed a bug with audio channels not being correctly routed for some types of sound files.

4.2.0- August 20, 2012
Added the Set In/Out Window

 



 

Added fade in setting in cart options
Action -> Set Fade Rates now only affects open racks.
Page Up and Page Down keys now take you to the previous and next rack.
The documentation is now opened by menu command shift H.
Fixed a bug that didn’t allow the output channel of mono sound files to be properly set.
Fixed a bug that could cause a crash under Windows, if the Preferences window is opened 
after maximizing a cart rack window.

4.1.2- October 2, 2011
Several bug fixes.

4.1.0 - July 22, 2010
Added rack archiving
Several additions for future versions of the iPhone/iPad remote control apps 

4.0.3 - June 11, 2010
Fixed a bug that would sometimes cause a rack window to not be correctly positioned when 
opened.

4.0.2 - May 28, 2010
Bug fixes related to the iPhone and iPad remote control apps.

4.0.1 - March 18, 2010
Bug fix - The sound devices menu was blank in a newly created Playlist window.

4.0.0 - February 18, 2010
Added the option to play a randomly selected cart when a group of carts are all assigned the 
same hotkey.

3.9.7 - November 19, 2009
Fixed a bug with playlists - dragging an entry past the bottom of the list could cause a crash, or 
duplication of another entry.

3.9.6 - November 6, 2009
Added the TALK button to change the volume of playing carts.
Can double click on a playlist entry to edit/delete it.
Added queuing option for carts.
Added ability to fade in playback of a cart by holding down shift and option/alt while clicking on 
the cart button.
Bug fix - Alphabetizing carts did not update rack window
Bug fix - Clearing rack did not clear cart names in spreadsheet window.
Bug fix - Indicator on cart not always turned off when a playlist is stopped.
Bug fix - Queuing and playing playlists assigned to cart buttons.
Bug fix - Properly resetting the cart volume after a fadeout.

3.9.5 - August 17, 2009

 



 

Bug fix - clicking on the progress indicator of an unused cart could cause a crash.

3.9.4 - August 13, 2009
Fixed a problem with the displayed cart title not changing after being edited.

3.9.3 - August 3, 2009
Fixed a problem with the cart title not appearing after a new file was dragged into a cart.

3.9.1 - July 22, 2009
No longer attempts to mount an unmounted volume on startup.
Reduced the delay in resetting the volume of a cart after a fade.
Fixed a potential crashing problem under Windows, when scrolling a rack window.

3.9.0 - May 12, 2009
Fixed a bug with default sound output channels.
Corrected a registration code issue.
Playlist windows can now specify the output device and channels to use.
Add... button added to the playlist window to directly select a sound file without dragging and 
dropping it.
Can delete playlist entries.
Fixed a bug that could cause a crash when a playlist window is closed.
Added a delay option to playlists.
Added control of which channels to use on sound output devices.
Remembers the size and position of the cart window.

3.8.0 - February 26, 2009
Added MIDI input.
Added support for using Function Keys as hotkeys

3.7.0 - October 30, 2008
Added an option to automatically display playlist windows that are assigned to carts.
Added an option to lock settings against unauthorized changes.
Added repeat option to carts.
When the cart size is made larger, the entire rack is now displayed.
Added the Click Pauses Playback option to the card options.
Added the Click Start Aborts Others option to the card options.
Fixed a bug that could cause a crash when pauses are used in a playlist.
Control-arrow keys can be used to adjust the volume of the selected cart while it is playing.
Can paste the registration code email into the registration code window.
Playing carts now show elapsed and remaining time.

3.6.0 - September 11, 2008
Added option to load sound files to memory.
Added options to set the playback pitch and rate of carts.
Added remote control option.
Added an option to toggle a serial port line when a track is playing.

 



 

Fixed a bug with the playback progress indicator
Fixed a bug that could cause a crash with the logging feature.

3.5.2 - May 29, 2008
Cart buttons that represent a PlayList now show the title of the next track
Bug fix: The first track in a Playlist would not always play.

3.5.1 - May 29, 2008
Bug fix: Pauses in play lists did not work.
Bug fix: Adding a pause to a play list could cause a crash/
Bug fix: Clicking on a progress bar on a cart linked to a play list could cause a crash.
Bug fix: bringing up the QuickTime details for an empty cart could cause a crash.

3.5.0 - April 24, 2008
The lock volume sliders menu option now also locks the progress indicator as well.
Added an option for a local preferences file in the application’s folder.
Added a better explanation of an expired registration code.
Added option to drag a playlist into a cart button.
Added the ability to vertically alphabetize carts in a rack.
Copy and Paste can be used in a Timed Playlist to duplicate entries.
Added an option to reset all Timed Playlist start times based off of the current or a specified 
time.

3.4.6 - February 21, 2008
Added an option to allow carts to be played backwards.
Click restarts playback now works with hotkey presses as well.
Fixed Apple IR Remote support for Leopard.
Bug fix - Some times the wrong cart would fade out.
Bug fix - play one track option in the playlist would not always work.
Bug fix - one second delay added before restoring the cart volume after a fade.

3.4.5 - November 29, 2007
Bug fix - couldn’t drag carts.

3.4.4 - November 29, 2007
Added icons for play list files.
Playlist windows retain their last position and size.
Click Restarts Playback now available on a per cart basis.
Bug fix - missing file would cause a timed play list to crash.
Bug fix - Mute did not completely mute looping sound effects.
Bug fix - playlists wouldn’t work correctly if the crossover time was left blank.

3.4.3 - October 4, 2007
Mouse scroller can be used to change the cart volume.
Added a menu item to close the frontmost window.
Added ability to pre-set playback starting position by clicking in the progress bar.

 



 

Added a window display a list of all timed playlists.
Checks to see if it is in a directory without write privileges, and quits if so.

3.4.1 - August 7, 2007
Added a volume control to playlists.
Bug fix - playlists didn’t use the selected sound output device.

3.4.0 - June 7, 2007
Added log file.
Added display of loop symbol for carts that will loop.

3.4.0 - June 7, 2007
Fixed a bug that could cause a crash if an invalid timed playlist file was opened.

3.4.0b2 - May 4, 2007
Added preferences option: clicking on a playing cart restarts it from the beginning.
Fixed a bug in the Cart Options window that made the Lock Volume checkbox disappear.

3.4.0b1 - April 24, 2007
Playing carts can’t be edited
Renamed Cart Editing to Cart Options, changed OK button to save
Made a confirm window for clear cart
Made a confirm window for alphabetize carts
Added a way to copy cart colors between carts
Cut in time for carts is now in tenths of a second
Added cut in and out times for playlists
Added fade time for playlists
If a cart is paused, clicking on it will un-pause
Location of the Cart Options window is preserved.

3.3.1 - April 20, 2007
Bug fix - clicking on the Details button for an empty cart would cause a crash.

3.3.0 - March 29, 2007
Added ability to select sound output device.
Added support for Apple IR Remote.
Can right click to open cart editing window.
Added menu item to lock/unlock all volume sliders in a rack.
Added continuous option to play carts one after the other in order.
Added option to allow the spacebar to abort playback like the ESC key.
Can set In and Out times for a cart.
Can set fadeout time for a cart.
Added option to copy a cart.

3.2.1 - February 22, 2007
Fixed a bug that could cause a crash by clicking in an empty playlist.

 



 

3.2.0 - February 22, 2007
Release

3.2.0b3 - February 13, 2007
Added Timed Play List.
Added clock on the rack window.
Added a time offset option to handle time delays.

3.2.0b2 - December 18, 2006
Added option to turn entire cart green when playing.
Added option to flash cart red when playback is almost over.

3.2.0b1 - December 14, 2006
First release with Universal Binary support.

3.1.6 - October 4, 2006
Improvements to reduce CPU utilization.

3.1.5 - October 4, 2006
Fixed a bug that could prevent a playlist from being saved.

3.1.4 - September 15, 2006
Sped up the opening of a rack window.

3.1.3 - September 11, 2006
Fixed a bug that could cause a crash when closing a rack or playlist window.

3.1.0 - September 6, 2006
Added option to import older rack files.
Added resize and scrolling of racks window.
Control-clicking a cart lets you start it at at an arbitrary point in the track.
Added window for quick access to all playlists.
Added indicator bar to playlist windows showing elapsed time.
Added option to add a pause playback marker to playlists.
Spacebar and return now start playback in a playlist window.
Arrow keys can be used to navigate a playlist window.
Left arrow will re-start a track in the playlist.
Right arrow will skip to the next track in the playlist.
Only need to click on an entry in the playlist to select it, not double click.
Fixed a bug that could cause playlist sound output to glitch.
Fixed a bug that could cause scroll bars to not be shown when they should.
Fixed a bug that could cause a crash when Sound Byte is launched.
Fixed a bug that could cause a crash if a rack was closed while a cart was playing.

3.0.0 - July 27, 2006

 



 

Improvements to sound playing under heavy computer load conditions.
Final Release.

3.0.0b4 - July 11, 2006
Added Clear Rack function.
Added function to alphabetize the carts in a rack.
Fixed a bug that could cause the regular version of Sound Byte to not allow all five racks to be 
used.

3.0.0b3 - June 11, 2006
Fixed a bug that could cause a crash if you tried to edit an empty cart.
Fixed a bug that caused some registration codes to not be accepted.

3.0.0b2 - May 6, 2006
Corrected some bugs with fading

3.0.0b1 - April 24, 2006
First beta release of Version 3

2.7.1 - March 26, 2006
Fixed a bug that could cause a crash when opening a Rack.

2.7.0 - January 8, 2006
Mute feature, kill sound output for voice-overs, etc.
Added preferences option for spacebar to play the next cart
Added preferences option to abort other playing carts when playing a new one
Added preferences option to pause playback of carts
Added preferences option to fade carts out 
Fixed a bug that could cause a crash if the Playlist window is used without a Rack window 
being open.

2.6.3 - October 7, 2005
Fixed a bug that could cause Sound Byte to crash when started up, if no Rack 
files exist. 

2.6.2 - October 7, 2005
Fixed a bug on systems with multiple volumes, where Sound Byte could lose track of sound 
files stored on volumes other than the startup volume. 

2.6.1 - September 27, 2005
Fixed a bug that could cause long waits when adding sounds.

 



 

2.6.0 - August 29, 2005
Added large display of details on the currently playing cart.
Enlarged the size of the displayed hotkey for better visibility.
Added feature to change volume numbers for all recording files in a rack.
Added a hot spot in the PlayList window in which to drop recordings.
Fixed a bug with fading - if a cart finished playing wile fading, the next cart played would start 
fading.
Some Tiger Mac OS X 10.4 related bug fixes.

2.5.0 - February 14, 2005
Auto-set cart size when a rack is opened.
Can now use space bar and arrow keys to navigate carts.

2.4.0 - February 14, 2005
Added the ability to display fewer but larger carts, for increased visibility.
Fade times can now be programmed individually for each cart.
Carts can be set to be disabled after being played, to make it easier to identify carts that have 
not been played yet.
Removed being able to click anywhere on cart to stop playback as it caused the sound to stop 
playing if you adjusted the volume. Now you need to click in the upper part of the cart button, 
where the title and playing time are located.

2.3.0 - November 4, 2004
Can now click anywhere on cart to stop playback.
Can now clear entries in Playlist window.

2.2.0 - May 12, 2004
Can pause the playback of currently playing carts.
Can start a cart at a particular time into the recording.
Can now drop multiple files into a rack at the same time.
Can clear all entries in a rack.
Volume indicators and progress displays for unused carts not shown.
After a fade, cart volume is now returned to previous setting.
Added checking for latest version and visiting website to About menu.
When a cart is dragged, the color now correctly updates immediately.

2.1.0 - March 4, 2004
Added the ability to fade the currently playing track.
Added display showing the elapsed time of currently playing tracks.
Added the ability to change the volume ID for cart recording files.

 



 

2.0.2 - February 6, 2003
Added ‘Sd2f’ and ‘MPG3’ filetypes to those recognized as valid sound files.

2.0.1 - January 12, 2003
Bug fix - couldn’t click on carts.

2.0.0 - January 11, 2003
Bug fix - couldn’t access sliders on bottom row of rack
Preferences menu item disabled (there are no preferences)

2.0.0b2 - November 30, 2002
Fixed bugs with saving play lists
Fixed bugs that could cause a crash when closing a rack
Fixed bugs with play list buttons
Fixed bugs with dragging clips

2.0.0b1 - First release of Mac OS X test version

 



 

Sound Byte Version History

Software License Agreement

This is a legal agreement between you and Black Cat Systems. covering your use of Sound 
Byte (the "Software"). Be sure to read the following agreement before using the Software. BY 
USING THE SOFTWARE (REGARDLESS IF YOU HAVE REGISTERED THE SOFTWARE 
OR NOT), YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE 
SOFTWARE AND DESTROY ALL COPIES IN YOUR POSSESSION.

The Software is owned by Black Cat Systems and is protected by United States copyright laws 
and international treaty provisions. Therefore, you must treat the Software like any other 
copyrighted material (e.g., a book or musical recording). Paying the license fee allows you the 
right to use one copy of the Software on a single computer. You may not network the Software 
or otherwise use it or make it available for use on more than one computer at the same time. 
You may not rent or lease the Software, nor may you modify, adapt, translate, reverse 
engineer, decompile, or disassemble the Software. If you violate any part of this agreement, 
your right to use this Software terminates automatically and you must then destroy all copies of 
the Software in your possession.

The Software and its related documentation are provided "AS IS" and without warranty of any 
kind and Black Cat Systems expressly disclaims all other warranties, expressed or implied, 
including, but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose. Under no circumstances shall Black Cat Systems be liable for any 
incidental, special, or consequential damages that result from the use or inability to use the 
Software or related documentation, even if Black Cat Systems has been advised of the 
possibility of such damages. In no event shall Black Cat Systems's liability exceed the license 
fee paid, if any.

This Agreement shall be governed by the laws of the State of Maryland. If for any reason a 
court of competent jurisdiction finds any provision of the Agreement, or portion thereof, to be 
unenforceable, that provision of the Agreement shall be enforced to the maximum extent 
permissible so as to effect the intent of the parties, and the remainder of this Agreement shall 
continue in full force and effect.

The Software and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of 
the Rights in Technical Data and Computer Software clause as 252.227-7013.  Manufacturer is 
Black Cat Systems., 4708 Trail Court, Westminster, MD 21158, United States of America. 

The name "Black Cat Systems", and  "Sound Byte" are trademarks of Black Cat Systems.

Sound Byte is ©1997-2015 by Black Cat Systems. All rights reserved worldwide.

 



 

 


